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Part 1

1. Signal StudioE O0|&8t LTE &S BHSD|

lo

1-1 Agilent Connection ExpertS 0| &8t &H| HZ5}D]

v Signal GeneratorS PC2} LAN cable2 ™ Z&tLILCEH
PC =20l Al Agilent Connection ExpertS A!8H A|2!L|C}.

nnection Expert

Filz  Edit
& Refresh All

Wigwr

10 Configuration  Tools  Help
123 Unda A Properties 18] Interactive |0 1 Add Interface 3¢ Delete

-
Instrument 1/0 on this PC LANInterface - LAN A
Refresh Al

= 9, cussaTaT
- B com (AsRLL)

Tasks for This Interface

@ Refresh this LaN interface

hange properties

COMIZ (ASRL1Z)
Chefgpthe b & comta pspLrs) WISA interface TCRPD
¥ CoM14 (ASRL4,
Ignore 2? COM‘EEASRUE; Protacaol type: Automatic
Delete S5 CoM3 (SR Connect 5000 Millis
S coMS (ASRLS) LAN maxirmurm 120 Seco
General Tasks : y
COME (ASRLE) Client defta 5 Seco
2 Refrech ol & SiCLinterface ID: lan
1 Logical unit 30
[ Add en instrument &5 usen oareatuny
Log connecterrors Yes

More Information Auro-discover: Mo
9 How do T connect?
@ How do T get drivers?

9 where: can 1 find
programming samples?

<
 Agilent VIEA

Add InstrumentS & €4 8L CH.

Add LAN Instruments

Search for an instrument
that is connecred ta the

LAN indirectly through a
gateway device or a LAN
server,

Advanced >

WISA address: TCPIPO:10.10.10.30:in5t0: NS TR

Test Connection | The instrurnent was successfully apened
| 1dertfy Instrument | Agilent Technologies, NS 1524, Myd3130424, A

& Both the address check and the identifcation were done

[] &uto-identify this instrument.

Instrument Web Interface. .

o J[ comed J[ ]

o | [ camesl | [ ek

MXGO| €& LAN AddressE “Auto Find” Tap2 2 & HLI “Add Other” Tap2 2 2 &tLICH



File Edit View

1#0 Configuration

onnection Expert

Tools  Help

& Refreshal ¥ Undo

Tasks for This Instrument

(2 Refrech ths instrument

Chargs propertise

Send commands ko this
iﬁ instrument

2] chanse the labe

W fdd 2 programming alias
=

2 i

K celere

General Tasks

2 refrechal
|‘$ Add an instrument
More Information

Q How do I get drivers?

Whers can I find
programing samples?

27 Propetties

Refresh All

= 4, cnussoTaT
7 comt (AsRLL)
S CoM12 (ASRLLZ)
S5 com3 (ASRLLE)
GF comi4 (AsRLLAY
S COMIS (ASRLIS)
U CoM3 (ASRL)
5 CoMS (ASRLS)
& COME (ASRLE)
= % LaN (TCPIPO)

B UsB/GPIE (GPIEO)

9 useo

19§ Interactive 10 BB Add Instument 198 Add Interface 3¢ Delete

() Both the address

AN Instrument - N5182A i

An instrument connected ta the LAN

eck and the ident

VISA address TCPIPO:10.10
st
IDN string Agilent Tech
Manufacturer: Agilent Tech
Model code: NS18ZA
Serial nurmber; My4516042.
Firmare A01.44
1P address: 10.10.10.30
SICL address: lan[10.10.10.
Address check: Yes
Auto-identifye Yes
e |
— |
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1-2 N7624B Signal Studio for 3GPP LTE S/WE& 0| &5t(H

for 3GPP LTE - RF Output (for Signal Generato

temn  Tools

Help

Ol Xl, N7624B Signal Studio for 3GPP LTES

>
0x
ol

LTE &S M

0

S AIZLICH

Dl & 1IE &)

- Quick Setups
=) Hardware

* Instrurnent
Licenses

= Waveform Setup
= Carrisr 1

Welcome to Agilent Signal Studio for 3GPP LTE

= &MNB Setup
- Transport Channel
- Physical Channel
- Resource Black

Would you like to run the application using

£ Simulated hardware

®F Dutput (for Signal Generator)
2x2 MIMO Tx [for Signal Generator)
44 MIMO Tx (for Signal Genzrator)
1 Ant Tx (for PXB)

2x2 MIMO T [for PXE)

MIMO Tx (for PXE)

M
£ Mast recently ussd hardwars configuration

& New hardware configuration

~|

[~ Don't show this dialog box again

e

c

|

Ready |

New hardware configurationg A€ $tutch

for 3GPP LTE -

OQutput (for Signal Generat

'ﬁ Agilent Signal Studi

\ Transport Channel
- Physical Channel
* Resource Block

File ‘iew Control Systern  Tools  Help
=y =]

Quick Sstups "R System Configuration Wizard
= Hardware

- Instrurnent Step 1 of System Configuration Wizard:

Licenses Select a function
= waveform Setup

=} Carrier 1

= eNB Setup

Select a function to perfarm from the list below;

2 Antennas
4 Antennas

o]

Cancel

Ready | [

1 Antenna® &€ &L|ICH



File View Control

System  Tools

Help

D= M|
Quick Setups
= Hardwars
Instrument
Licenses
= Waveform Setup
B Carrier 1
= eNB Setup
- Transpart Ch.

- Physical Channel
Resource Block

o

annel

step 2 of System Configuration Wizard:

Select a hardware configuration

Chaose a hardware configuration from the list of supported
configurations:

PRE
16800/16900 Logic Analyzer

ESGIPSGIMAG Signal Generator

< Back I Next > I

lew  Contrel

) Agilent Signal Studio for 3GPP LTE - RF Output (for

nal Generator

System  Tools

Ready [
ESG/PSG/MXG + Internal ArhS & &4 &HLICIH

Quick Setups
= Hardware

* Instrument
Licenses
= Waveform Setup
= Carrier 1

= ehB Setup
Transport Chann
Physical Channel
Resource Block

Step 3 of System Configuration Wizard:

Select a specific hardware system

el

Select a specific system from the list below or select
=Mew> ta configure a new system (the list shaws all
applicable, previously saved hardware configurations for
the current function):

Wiew Details

Delete

< Back I Hext = I

Cancel

Cantral

System

<New>E & §L|CL

Tools.

Help

Quick Setups
= Hardware
Instrument
Licenses
(= Waveform Setup
= Carrier 1
= eNB Setup
Transport Chan

Resource Black

<l |

Physical Channel

Step 4 of System Configuration Wizard:

Select an ESG/PSG/MXG Signal Generator

nel

Enter the ESG/PSG/MXG Signal Generator connection
infarmation below

Wiew

@ Enter a new ESG/PSG/MXG Signal Generstor: Properties

Test IO
Connection

Hostname /
1P Address

10.10.10.30

Ghooss an ESG/PSG/MKG Signal Gensrator
" from the list of configured interfaces in 1o
Libraries:

< Back Next > Cancel

Ready | [

ZOlA LANS KSEi5I0 MXGO| ZZAE IP AddressS

olad
[= ]

gL Ch




(

‘W Agilent Signal Studio for 3GPP LTE - RF Output (for Signal Generator}

File View Control

System Tools Help

D& @
Quick Setups
= Hardware
Tnstrument
~Licenses
= Waveform Setup

L

Step 5 of System Configuration Wizard:

Test 1/0 connection for ESG/PSG/MXG Signal
Generator

SEE = System configuration listOll Al O 0|2

) Carrier 1

£ eNB Setup
Transport Channel
Fhysical Channel
Resource Block
Testing /0 conneetion for ESG/PSG/MXG Signal
Generator at TGPIPO::10,10.10,30: INSTR ..,

ESG/PSG/MXG Signal Generator connected.

Press the Next button to continue,

< Back I Next > I

Cancel

Ready |

NextS

SENELICH

File Wiew Control

System Tools Help

DS HE
Quick Setups

= Hardware
Instrument

|

Step 6 of System Configuration Wizard:

- Licenses
= Waveform Setup
= Carrier 1

system.

Enter system name and start using the hardware

= eNB Setup
Transport Channel

Fhysical Channel Enter the name of the hardware system:

Resource Block e ot

Summary of System Details:

- ESG/PSG/MXG Signal Generator:
TCPIPD::10,10,10,30::INSTR

<Back| Finish I

Cancel

Ready

OI2 olS0lLt =HstLIC
£ dE5IH &3 Al2t0l
2

20lA FinishE &GS Otciet 2

20| LIEHELICH

e= gudy)



gnal Studio for 3GPP LTE - Untitle:
File “iew Control Systen Tools Help

D @& 11 4

Quick Setups

Configuration : LTE DL 1 Carier [2008-03]

£ Hardware
Instrument ﬂ +-| %
e Carier_| State | Radio Fomat [ Configaration [ Frequency Oifset_| Power
T Cavier1 On  BasicLTE FDD Downlink (200803]  Fulfled OPSK 5MHz(25AB)  0000000Hz 00048
5 eNE Setup
Transport Channel
Physical Channel
Resource Block “waveform Attibutes I Hint
g
Wavefoim Name Untitled
Cormment
143 Map Nomal
B
Marker 1 Source Frame
Maker 2 Source: Nore
Matker 3 Source: Nore
Matker ¢ Source Nene

| CEDF | waveiom

Ready | Connected

2% TreeOl A “Hardware” S &Eol3 HZE MXGHEHIS HEE 2 = USLICH

File View Contral Systern Tools Help
D™ 110

Quick Setups | Run Self-Tests Test 1/0 Connections

Instrument =]
Licenses
= waveform Setup
= Carrier 1 El
- eMNB Setup
Transport Channel
Physical Channel
Resource Block

41 | ]

Ready Connected




lent Signal Stud

for 3GPP LTE

File View Control System Tools Help
D 1E| &
Quick Setups ‘Lmnm ‘
I™ Hint
e NN ¥ |Stete | Featue | Description Instrurent Licerise | =
S 2 [On  [NB24BF™ |Basic 35PP LTE(2007.09) Vaid
= eNB Setup 3 On  |N7B2BO™ |Advanced 3PP LTE(2007-09) Vaid
TrenspottiChanie| 4 |on M7E24B-G™ | Basic 3GPP LTE[2002:03] Valid
Physical Channel "t
Resource Black 5 |On  |NFEZMBA™ | Advanced 36PP LTE(200803) Vaid
6 On  |NEZMBH® | Basic 35PP LTE(2008.09) Vaid
7 |On  |[N7E24BS™ | Advanced 3GPP LTE(200805) valid
8 [On  |N7E24Bn™ | Instrument Connectivity Vald =
CarerName State Reuited Feature 1 Required Featue 2 -l
Basic LTE FDD Uplink (2008-03) \Awalebls | Basic 36PP LTE(2008-03) /A
Basic LTE FDD PRACH (2008.03) Available  Basic 35PP LTE(2008.03) /A
 Advanced LTE FDD Downlnk 200803  Avaleble  Advanced 3GPP LTEI2008.03)  Basic 36PP LTE[2008.03]
Advanced LTE FDD Uplirk (200803]  Availsble  Advanced 3GPP LTE[2008.03]  Basic 3GPP LTE(2008.03)
Basic LTE FOD Downink (2008.09) Available  Basic 3GPP LTE(2008.09) /A
Basic LTE FDD Lipiik [2008-09) Available  Basic 36PP LTE(2008.09) /A
 Basic LTE FOD PRACH [2008-09) Available  Basic JGPP LTE(2008.09) /A
" Advanced LTE FDD Downlink [200809) | Availsble | Advanced 3GPP LTE[2008-09) | Basic 35PP LTE(2008.09)
| Advanced LTE FDD Uplink (2008:09) | Available | Advanced 36PP LTE[2008-09) | Basic 36PP LTE(2008.09)
Basic W-COM FDD Dewnink Available  Basic 36PP LTE(2007-09) N/A
i ik " Basic W-CDM# FDD Upink Available  Basic JGPP LTE(2007-09) N/A -
Ready [Connected |
Tree2| LicensesOll A= InstallE License statusS 20l ot&l £ USLICH
BIZ Z0IA Waveform SetupES SN HEE =, QEX & A0

2¢zal
=27

gL Ch

Configuration=

DEE @17

Quick Setups
= Hardware

Instrument

=l Carrier 1

uratior
Ful filed QPSK 5MHz (25 RE)

0.000000 Hz

0.00dB

Qe Predefined

= eNB Setup

Base Channel Configuration

Transport CF = Contents
Physical ChETE b1 1 Carer (200707) 1 carter configued wilh LTE Downlnk (2007-07)
Resource B|

LTE UL 1 Camier (2007-07)

LTE DL 1 Cartier [2008-03)
LTE UL 1 Carrier [2008-03)
LTE PRACH 1 Carrier [2008:03)

LTE DL 1 Carrier (2008-03)
LTE UL 1 Carrier (2008-09)
LTE PRACH 1 Carier (2008-03)

LTE DL 1 Carrier with W/-COMA DL 1 Carier (2007-07) Caniers configured with LTE Downlink (2007-07) and W-CDM& Downlink TM1 84DPCH
LTE UL 1 Carrier with W-COMa UL 1 Carrier (2007-07) Caniers configured with LTE Uplink (2007-07) and W-COMA Uplink HSPA.

LTE DL 1 Carrier with W-COMA, DL 1 Carier (2008-03) Casiers conligured with LTE Downiink [2008-03) and W-CDM# Downlk TM1 54DPCH
LTE UL 1 Cartier with W-COMA UL 1 Carier (2008-03) Carriers configured with LTE Uplink [2008-03) and W-CDM# Uiplink HSPA

1 cartier configuied with LTE Uplink (2007-07)

1 carter configured with LTE Downlirk (2008-03)
1 cater configured with LTE Uplink (2008-03)
1 carier configured with LTE Uplink PRACH Preamble 2008-03)

1 carier configured wilh LTE Downlink (2008-03)
1 caier configured with LTE Uplnk (2005-09)
1 catter configured with LTE Uplik PRACH Prearmble (2008-09)

LTE DL 1 Carrier with W-COMA DL 1 Carrier (2008-09) Caniers configured with LTE Downlink (2008-03)

and W-CDM& Downlink TM1 64DPCH

LTE UL 1 Carrier with W-COMA UL 1 Carrier (2008-09) Cariers configured with LTE Uplink (2008-03) and W-COMA Uplink HSPA.

Lo |

‘Predefined Configuration’

Z0lA “LTE DL 1 Carrier (2008-03)"S & E&{&!LIC}

File ‘iew Control System Tools Help
[RE=y=] 1 o
Quick Setups Configuration : LTE DL 1 Carier [2008-03)
= Hardware
Instrument
Licenses
Configuration Frequency Offset
= Waveform Setup = =
- Carrier 1 Full filed 0
=i eNB Setup
Transport Channel
Physical Channel
Resource Block Waveform Attributes ™ Hint
2]
Wavefarm Name Uniitled
Comnent
143 Map Hormal
a
Marker 1 Source Frame
Marker 2 Source Hone
Marker 3 Source Hone
Marker 4 Source None
B | ECDF | wavelom
Ready  Connected




File View Control Systerm Tools Help

D& @11 &

Quick Setups |Enr\hguratinr\ < LTE DL 1 Camier (2008-03)
5 Hardware
Instrument |+
i t:;i”;i:m o Carier | State | Padio Famat [ Configuration [ Frotuency Difset | Power
e Camier1 On  Basic LTE FDD Downlink (200803 Ful hiled OPSK 5MHz (25 RB) 0.000000Hz no0d8
= eNB Setup
Transport Channel

Physical Channel

Resource Block I Hint

LTESMDL

140 Map Moimal

Marker 1 Source Frame

Marker 2 Source None

Marker 3 Source None

Marker 4 Source None
b| CODF | wavefom|

Ready |Connected

'Waveform Properties’ 0l Al Waveform Name (0il, LTESMDL)S 2!28tL|C}.
v Note: E&HHZE 0|=E2Z Waveform I} 0| MXGO XZ0| ELICH

"W Agilent Signal Studio for 3GPP LTE - Untitled=
File ‘iew Control Systern Tools Help

Dl &1 1E 4

Quick Sstups

Instrument
= Hardware
Updatc olnstument | Updste fomnstmert | 1ocol | [IEESEIN  occa
Licenses
= Waveform Setup Instrument Conlroks I Hint
= Carrier 1
= eNB Setup =] =
Transport Channel
Physical Channel
Resource Block Parameter O ptimization Auto
Peaiform DC 1/Q Calibration On —
Frequency 1.000 000 000 000 GHz
Amplitude -10.00 dBm
RF Output On
1413 Adjustments ot

ol | >l -

Ready Connected

2Z Z0|Al InstrumentS SHEGID) Frequency?t AmplitudeS B1Z8tLICH

v Note: Frequency2} Amplitude= O0|Z 0| MXG ZHINAE HH Jts8HLICH

'ﬁ Agilent Signal Stud r 3GPP LTE - Untitled=

File Wiew Control Systern Tools Help
=y =] 1IE| 4

Quick Setups ‘Inslrumenl
= Hardware
Instrument Update ta Instument Update from Instrument Local |- DCCal
Licenses
= Waveform Setup Instrument Cantrals I Hint
=l Carrier 1
= eNB Setup =] Sl
Transport Channel
Physical Channel
Resource Block Parameter Optimization Auto
Perforn DC 1/Q Calibration On |

2.400 000 000 000 GHz

Amplitude -10.00 dBm
RF Output On
143 Adjustments aff

o1 | ] =

Ready |Connected

10



= EH= = = = =
2% Carrierl2 & E45t10 Channel configurationOl Al 18J1X] B & olLIS SEHEILICH
g BEH
=y =} 1E &
Quick Setups |Cunligulauor\ : LTE DL 1 Carrer (2008-03)
=) Hardwars
Instrument J -
;‘,“:V";f;m ot Carrier_| State | Radio Format [ Configuration | Frequency Offset | Power
rm— Canier1 On  Basio LTE FDD Downlirk (200803)  Fullfilsd OPSK BMH2 (25RB] 0000000 Hz 00008
= 8MB Setup
Transport Channel
Physical Channel ) _
Resouteo Bloe  Carier 1 - Basic LTE FOD Downlink [200803) I Hint
= =
Stale On
C Ful filed OPSK EMHz (25 FE) -
Fullfllsd (PSK. 1 4MHz (5 B) ~
=] Fullfiled 1602M 1 4MHz (B RE)
Oversampling Fiatio Fullilsd G404M 1.4MHz (6 RE]
Pre-Fiter Clipping Fulfilsd (PSK 3MHz (15 RE)
PuashFiter Clipging Fulliled 1504M 3MHz (15 RE)
Full il 404N 3MHz (15 B
Fi Offset
Foeney T Fullil=d 1504M SMHz (25 )
T Giteet Fullfild E404M 5MHz (25 B
il \gPh Full filed GPSK 10MHz (50 RB]
nitiel Phase Fullfiled 1604M 10MHz (50 FB)
Symbol Rolclf Length Fullfiled E4T4M 10MHz (50 FIB) |-
Baschand Filer Full filed FSK 15MHz (75 FB) 2
1 »| CCDF | waveforn -
Ready |Connected

Generate Waveform key

[I

0:

tT|= CCDFgtS ol &

A
-

USLICH

"R Agilent Signal Studio for 3GPP LTE - Untitled~ =]
File “iew Control System Tools Help
bDeEd 1 o
Quick Setups ‘Eunl\gulatiun LTE DL 1 Carer (2008-03)
= Hardware
Instrument J X
i ;&Zi”:;im = Cartier_| State | Radio Format [ Configuration [ Frequency Offset_| Power |
i Camier1 On  Basic LTE FDD Downlink (200903)  Ful filed @PSK SMHz (25 RE] 0.000000Hz 0008
=leNB Setup “wlaveform Attributes ™ Hint

Transport Channel

! |

Ready Connected

Marker 3 Source
Marker 4 Source

CCOF | wavetom |
B Gaussian

5 Reference

it Acquire Ref

Physical Channel B

Resource Block Waveform Name LTESMDL
Camment
1/0 Map Womal
Marker 1 Source Frame
Marker 2 Source Hone

RF ALC Control
RF Blanking Control

File  Control Srgr‘m Tools

M Al U= ‘Generate and Download'd| [O & H | & Il_l

0l MX6ZE C+2=2E& FLICHL

YUHOZ Downlink &

X0 et ded

AMHz, 3MHz, 5MHz, 10MHz, 15MHz, 20MHz
Gl0l IS E BtE0| 225 StAIE LI

Uplink 1

11

EE

= ™ Waveform

A SES QPSK, 160AM,



W Agilent Signal Studio for 3GPP LTE - Lintitled=
File View Control Systern Tools Help

e @11 o

Quick Setups Configuration : Full filed OPSK 5MHz [25 REB]

—I-Hardware
Instrurnent Q
Licenses
= Wavefarm Setup el Setup = Hint
= Carrier 1 g

Physical Layer Cell ID Group 1]
Transport Channel
Physical Ch | Phwyzical Layer Cell ID Sector u]
ysica anne First M-Sequence for Scrambling Code Generator 1
Resource Block BNTI 1
Antenna Fort 0
Total number of Antennas 1 Antenna
Syztem B andwidth 5 MHz [25RE]
Cyclic Prefis Mormal
Pre-clocking number far PRES 1600
=
Cell specific Reference Signal Pawer 250 dB
=
Frimary Synch Signal State On
Frimary Synch Signal Power 0.65 dB
Secondary Synch Signal State On
. j Secondary Synch Signal Power 0E5dB

Ready |Connected

2% eNB Setup Tree2 MEi5ID ERF J|XI=2 ParameterES &3 & 4 USLICH

1-3 .scpfile Bt=D|

1-3-1 .scp file2 Signal studio®| Setup file2| A XY L|ICH

1-3-2 Signal Studio2| Setup0| ZL+H * Generate Waveform” button # 2 s=sUCH

1-3-3 OO0l Al File2 &E46t0 “Saveas..”S SE{&ILICH

1-3-4 EEXHOl scp & XS Ol StAILD HE ELICH

1-3-5 scp 2 HEE OIY Open Gl0 2229 .scp MHEBCAE SEH
CHZ CHAl Signal StudioJt SetupOl ELICH MitA sep UG AZ B/E
CtH Signal StudioE CtAl 8&St= BIHZSS & I USLICHL

|0 IIII

1-4 .wim file B+SD|

1-4-1  .wimfile2 Signal StudioJ} QtS %= U= Waveform file L|C}.
1-4-2  .wim file2 Signal Studio AF2 20| MXGOI HIZ2 S0 A AI=2E £ U=s It
2L|Ct
1-4-3 .wim file2 Qt=J| fHME Signal Studio2 Setup0| ZLIH “ Generate
B g csun.
1-4-4  “File"0fl “Export Waveform Data”" &
g2

1-4.5 ESETHO0.winCZ XHZO|

=0

o
A

Waveform” button

S BLICH
B0l sta = ASUICHL

12



1-5 .wimfileE USB MemoryE AI23t0{ MXGO| Copy S|

1-5-1 NZ&EE wim LS USB Memory stick0ll HZS &HLICH
1-5-2  USB Memory Stick& MXG & 22| USB Port0f &l 8tLICt

FREQUEHGY AHPLITUDE USB lNedia

1.000 00000000 s __-10.00_cen Uyt

Copy File to

RB

L2
USE Directoru: 7 E711E Fres Instrument
(This path is the default path?
File Hame Tupe Hodified

LCOMA_GSMGPRS_SFPTA_DB_Enolish. mdb
LibroTFA. M

12
g

Delete File or)
Directory

Create Directory

Ua/27/2003 17:50 More 1 of 2

1-5-3 1| 31E 0I5t CopyE FileS &0} H&i3t1] “Copy File to Instrument”
g &< &Lt

FREQUENCY ANPLITUDE Copy File As

1.000 00000000 s | _-10.00 an Sween List

Instrument State

USB Directoru: / EFIME Free

(This path is the defsult pathi

File Hame Tupe Size Hodified User Flatness
HCONA_GSMGEPRS_SPTA_DE_English.mdb 1] 12 Correct.ions

LLibro1FALLIFM

‘ Sequence

O2/27,/2000 17:51 |

1-6-3 “Waveform"S &€ §HLICH

FREQUEHCY AMPLITUDE

1.000 00000000 &= | _-10.00 cn 68 renory

RB

Internal Storage

USB Directory: / E7IME Fre
(This path is the defsult path)
File Hame Tupe Size Nodified

HCOMA_GSMGPRS_SP TA_OB_Fnglish.mdb 2HB  06/03/08 12:30
HibrofFA.Lfm [

0z/27/2003 17:53

1-5-4 “BBG Memory” &2 “Internal Memory"E & &i8LIC}.

FREQUEHCY AMPLITUDE
Select Waveform
1.000 000 000 00 &= -10.00 oen JoFRisRiastR
I ARB ERR
Display Haveform,|
Select Segment On Sequence On fnd Markers
(1/1) BBG Hedia Points Int Hedia Segs
BAMP_TEST_LFH 200 STREAHSED 1 aweform
SIMNE_TEST_HFH 200 Segment.s”|
UMTITLED 100000
WIBRD1FA. LIFH 200000
WIBRD 1FA 100000
HWIBRO_1FA_LL 100000
Goto Rouwk
Oo/27/2009 17:55

1-5-5  USB MemoryE XIHSt) MXGOIAl CopyE FileS &EisHLICE

13



Part 2

2. 89601AVSAS O| =8t LTE downlink &3 245t
o ole A wAZ NzE B T

Spectrum and time domain measurments

Get basics right, find major problems

Basic digital demodulation

Signal quality numbers, constellation, basic error vector measurement
Advanced digital demodulation

Find specific problems and causes

Vol €3
® SAS| ‘TRIGGER 1In'2 MXG2 ‘Event1'S BNC OS2 HASILICH

® 89601AVSAS/WE AIEBILICH

Change the RBW filter and increase the
frequency points for better resolution.
The auto frequency points selection
chooses the best resolution for the
given time capture. You can change
this if you prefer.

Meas Setup > ResBW > ResBW Mode > Arhitrary
{pull down menu)

Frequency Points >Auto

Time (tab) = Main Time Length > 900 usec

Click Close

Right click in Trace A. Click Y Auto Scale

Auto scale Trace A and Trace B Right click in Trace B. Click Y Auto Scale

nt 89600 Vector Signal Analyzer

Edit Contral Sgurce Input TestSetup MeasSetuy lay Trace Markers Utilities Help

rilje | ®@BODEE Sucked? v [ o || 1] E -

Measurement running INT REF CAL: 0K

Center =I}4Z 2.4 GHz=Z, SPANS 5MHzZ, RangeE 0V10| EX| &= Level2 & ASHLICEH

14



1.1 [Measuring OWB]
60 or2Het 20l &3 §LICH

®  Occupied Bandwidth(0BW)E = A 6}D|
o ) Right-click Trace A
Display OBW race Select Show OBW
Double click the Trace B title (B: Ch1 Main Time)
Select Marker from the Type menu on the left-hand side of the box
Activate 0BW Summary table Select Obw Summary TrcA from the Data menu on the
right-hand side of the box.
Click 0K
® Of2iet 20| Summary datatable2 Sd 0BWE =X E £ USLICHL
P lent 89600 Vector Signal Analyzer
Eile Edit Control Sgurce Input TestSetup MeasSelup Display Trace Markers LUtilities Help
(RS TRE @@@@@@SlackedE - ] H
. Range: 0 dBm

Loghag

INT REF

Measurement paused

e [IE =FE Aol 0BWE OteHt 20| CleargtLICl.

Double click the Trace B title |B: TrcA 0BW Summary Data)
Select Channel 1 from the Type menu on the left-hand side

of the box that appears.
Select Main Time from the Data menu on the right-hand side of

Clear 0BW display
the box.
Click OK
Right-click Trace A
De-select Show 0BW
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1.2 [Measuring Band Power]
® BandPower E3Z2 ol Ootcer 201 &3 &LICH

® X, SPANS 6MHzZ =& &LICH

® Toolbar2 Marker0Ol Al CalculationS & &4 &HLICH

® Band Power2| Center 3=I}==, WidthE &€ &LICH

e
File Edit Control Source |nput TestSetup MeasSetup Display Trace Markers Utlities Help

- @@@@@@Sta:kedZ -

Posiion Calculation | 0B | ACP] Limits | Spectrogram |

¥ Band Power L ’
W Centerfwidth >

Center  [aGH:

widk  [Earz

Calculate: ,W‘

Close ™ Keep Open

INT REF CAL: 0K

9 J8lo StHUlM S3E 1D U= Channel2] PowerE &0l & £ USLICHL

Measuremeant runhing
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1.3 [Basic Demodulation]

® 22 &= 5MHz Downlink LTE signalS DemodulationStJ| I Oteiet 201 £ & EHLICH

Display > Layout > Grid 2x2
{Or alternatively, Click on the drop down menu near the top of the
menu.

Change the display to show four traces

ina 22 grid
Select Grid 2x2 from the available options.)
Select the LTE demodulatar MeasSetup > Demodulator > 3G Cellular > LTE
MeasSetup > Demod Properties = Format (tab)
Click Downlink from the Direction: drop down menu.
Click the Preset to Standard... box and select 5 MHz {25 RB})
from the drop down menu
Go to Profile jtab)
Click the Edit Control Params box
Set up the demodulator for downlink Make sure the PDCCH Allocation field is set to 3 for each
analysis Subframe |Sf) S0 thru Sf3

See below for descriptions of each tab UL |i EEN AR
and the parameters available
Click OK.

Go to Format tab)

Make sure Auto is selected under Cell ID

CID
™ Auo Manusl

Select automatic detection of Resource Go to Profile (tab)
Check RB Auto Detect (Nater This setting is checked by default]
Blocks (RE) Click Close

Begin demodulation Press Restart | b

Your display should look similar to Figure &

17



nE s += USUILCL

2
=2

ofl OteHet 22 Default LTE Demodulation
o [i M| &

O

o 9 &3
@ @ @ D E F Gnd2xE

File Edit Control Source Input TestSetup MeasSetup Display Trace Markers Utilities Help
. L3

» 1

dBm
Measurement running LTE INT REF Cal: Ok
® =3 DpataS 0|50 Frame SummaryE 2J| |6 Oteiet 201 &3 &LICL
Double click the Trace C trace title {C: Ch1 OFDM Err
Change Trace C to show the frame Vect Spectrum)
summary In the Data: column select Frame Summary
Click 0K
X Right click on Trace B
Auto scale Trace B Selact Y Auto Scale
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F=IIE2Z RB, Sub carrier, Slot, Symbol & EVME £4 olJ| M= Oteligt 20l

C

rii' Agilent 89600 Vector Signal Analyzer

File Edit Control Source [nput TestSetup MeasSetup Display Trace Markers Utilities Help

L3 N

Measuement nning

ADEODE® Gd2e -

k

LTE INT REF CAL: 0K

b

Change the display to show six traces

Select Grid 3x2 from the layout drop down menu

Change Trace B to show EVIM per
Resource Block (RB)

Double click the Trace B title {B: Ch1 Spectrum)
In the Data: column select RB Error Mag Spectrum
Click 0K

Change Trace C to show EVIM per
subcarrier

Double click the Trace C title (C: Ch1 Frame Summary)
In the Data: column select Error Vector Spectrum
Click 0K

Change Trace D to show the frame
summary

Double click the Trace D title {D: Ch1 Error Summary)
In the Data: column select Frame Summary
Click 0K

Change Trace E to show EVM per
time slat

Double click the Trace E title (E: Ch1 OFDM Err Vect Time)
In the Data: column select RB Error Mag Time
Click 0K

Change Trace F to show EVM per
symbol

Double click the Trace F title (F: Ch1 Frame Summary)
In the Data: column select Error Vector Time
Click 0K

Auto scale all traces (except Trace D)

Right click on each trace and click Y Auto Scale

19

H2FEU



& Agilent 89600 Vector Signal Analyzer

File Edit Control Saurce [nput TestSetup MeasSetup Display Irace Markers Utities Help

®®O DO @O Gidxe

-
L]
@
-
®
3
4
-

tunning

LTE INT REF CAL: OK

1.4 [Measuring EVM on specific symbols]
e Ot J8XE S&F Slot, S& Symbollil UEt E4E & &+ ASLICH
®  Demodulation PropertiesOll Al Time= & & & LIC}H
® X Slot2H0l A= 181 SymbolOll CHE 24 S 60| AWM= Otchet 201 £&FELICH
®  Result length 20, Measurement Slot offset 0, Measurement Symbol offset 0, Measurement Slot Interval 0,

Measurement Symbol Interval 12 & & 8tL|Cl.

o =1ES
Flle Edit Control Saurce Input TestSetup MeasSetup Display Trace Markers Uiliies Help
ril e |@E@O@®EM® MR~ ke M| # >

Fomat | Profie Time | Advanced|

Result Length 20Slats

Slots Symbols
Measuement Offset;  [TETAR [0 symboltimes

Measuement Interval; [0 Slots [1 symboltimes

Analysis Stat Boundary
& Frame © SubFrame

© Half-Frame  Slat

Timing Diagram
Res. Len: 20 Slots —

I Mess it

' Mess 0 00

Frame By

Close | ™ Keep Open

Measuiement unning

INT REF
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3. 89601A VSAZE O0I&& LTE Uplink

® X, Downlink2 S StH N7624B LTE Signal StudioE 0| &

OtO4 LTE uplink

" Agilent Signal Studio for 3GPP LTE - AF Output (for Signal Generator)

File View Control Systern Tools  Help

O LiESA
Quick Setups ‘Canfiguratiun: LTE UL 1 Carrier (2008-03)
= Hardware
Instrument ﬂ M x
4 t\ltc;e\fnesfiim Setu ATIET ate adio F ormal ‘ Configuration ‘ Frequency Offset | Powier |
5 carrier 1 P Carier 1 On Basic LTE FDD Uplink (2008-03) Full filed QPSK BMHz (25 RB) 0.000000 Hz (.00 dg
- UE Setup
Transport Channel
Physical Channel X .
Resource Block Carrier 1 - Basic LTE FDD Uplirk (2008-03) I Hint
el 1=
State On
Channel Configuration Full filled GPSK BMHz (25 RE)
=]
Owerzampling R atio AUTOD
Pre-Filter Clipping 100.0 %
Post-Filter Clipping 100.0 %
Frequency Offset 0.000000 Hz
Power 0.00 de
Timing Offget o
Initial Phase 0Deg | |
Symbal Rolloff Length 0Ts
Baseband Filter On j
4 _»| CcoF ]W’avefmm]
Ready
= =y = Lot = = = “ ”
® 89601A VSA S/WE 4A/84510{ Center =I=== 2.4 GHz, SPANS bMHz, RangeE “0V1

LIXl &&= Level2 ZZFGH0 Ofcii2t 20| LTE5MHz Uplink &S E

ﬁ Agilent 89600 ¥Yector Signal Analyzer

FELICHL.

File Edit Control Source Input TestSetup MeasSetup Display Trace Markers Utilities Help

& b} © @O E ® Stacked 2 - |

LR

:1E
i

Measurement paused

o i M

W \W. m‘[{ V || Jll l| Mw “u [I “M(

i

Y

INT REF
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\

Ote 2t 20| LTE DemodulatorS & EHEHLICEH

Agilent 89600 Vector Signal Analyzer

File Edit Contral Sgurce Input TestSetup MeasSetup Display Trace Markers Utiliies Help
® 0 D) (E) (By Stackec

Ch1 OF]

[ S

Measurement rwnning

LTE Demod PropertiesZ 2| FormatOll Al Direction2 Uplink=2 Bandwidth

BtLICH

Frequency Bands

FErequency...
ResBiW,.,
Time...
Awerage,

Dermod Propetties

TE Demod Properties

Demod Off

Analog Dermod

Digital Dernod
1D

W-CDMA (3GPPI/HSPA

Wiraless Metworking
Broadband Wireless Access
Public Safety
Uhtra-tideband

1=EV-DO

1ETES INT REF

] Advanced ]

Direction: e L |
Uplink 5 MHz [25 RB) _vl Preset to Standard... |
TreT 20 kHz (100 REB)
Whie 12415 15 MHz [75 RE)
+ PUSCH DM-RS 10 MHz [50 RE
~
3MHz [15RE)
1.4 tHz [E RE] d
Uplink Format Paramaters

[~ 10 Offset Compensate

v Half Subcarrier Shift

[v PUSCHDFT Swap

Cloze ™ Keep Open

Help
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® Demod PropertiesZ 2| Profile0ll A Edit User Mapping2 29 MJ|= LTE Allocation EditorZ0{| A

2 MSO| RBIW=0l S RBEnd gtS &3 ELICH (ex. 5MHz 25RB = RB Start 0, RB End 24)

| Tt

Fomat  Profle | Time| Advanced
. i Name CellID nee °"  Group Hopping Seq Hopping | Include PUSCH | Include PUCCH
Uplink Channel Mapping Parameters RE Auto-Detect User 0 |0 0
v REB Auto Detect
Eomprsits lnelods PUSCH Channel Parameters Per-slot Parameters
PUCCH 7 Couple
+ [ User_01 Sync Slet |0 F
I Nonlloc B Edi User Mapping S RE Start 0
O 1Re 'arameters — o
b Mod Type
”:;“ Pawer (dE) 0
= DMRS Group (u) /[0
DMRS Seq {v) 1]
24 DMRS Cyclic Shift 0
DMRS Fower (dB) ||| 0
RE RE Mapping for PUSCH
24
RE
o 0
0 Slo: 0 Slot 13

#
-
o
.
-

e

it

e pa

LR RN
£

*ragp s

INT REF

Daing demadulation

- Eond -
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